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Introduction

This tutorial shows how to interface and handle communication between user logic in the field
programmable gate array (FPGA) fabric and the SmartFusion®2 microcontroller subsystem (MSS). It
also explains the Microsemi® Libero® System-on-Chip (SoC) design software tool flow for designing
applications for the SmartFusion2 system-on-chip (SoC) FPGA family of devices.

A SmartFusion2 SoC FPGA device has two fabric interface controllers (FIC_0 and FIC_1) as a part of
the MSS. These FIC blocks provide a means of interfacing from the SmartFusion2 SoC FPGA MSS
AHB-Lite (AHBL) bus to user masters or user slaves in the FPGA fabric: Each_ FIC block performs an
AHBL to AHBL or AHBL to APB3 bridging function between the AHB Bus Matrix and'AHBL or APB3 bus
in the FPGA fabric. Each FIC block provides two bus interfaces between the MSS and FPGA fabric. The
first one is mastered by the MSS and has slaves in the FPGA fabric; the second one has a master in the
fabric and slaves in the MSS. The bus interfaces to the FPGA fabric can be either 32-bit AHBL or 32-bit
APB type. The FIC block provides registered bridging between the MSS AHBL interface and the FPGA
fabric AHBL/APB circuitry to run at frequency ratios of 1:1, 2:1, 4:1, 8:1, 16:1, or 32:1. In AHB-Lite
configuration, a bypass mode is provided, in which sighals to and from the fabric are not registered and
hence requires fewer clock cycles to complete each fransaction: SmartFusion2 SoC FPGA FIC has six
memory regions. You can allocate a memory region to a particular FIC that is either to FIC_0 or FIC_1.
Each memory region has a predefined memory map. Refertothe Fabric Interface Controller chapter of
the SmartFusion2 Microcontroller Subsystem User Guide for more information on FIC blocks.

After completing this tutorial, you will be familiar with the following:
1. Creating a project for a SmartFusion2 SoC FPGA using the Microsemi Libero SoC toolset.

2. Using SmartFusion2 SoC FPGA System Builder to Configure MSS and generate System Builder
Component.

3. Configuring fabric interface ‘controllers (FIC_0 and FIC_1) to interface user logic in the fabric with
the MSS.

Using on-chip oscillators and fabric CCC (FAB_CCC) for generating system clocks.
Writing a simple bus functional model (BFM) script for simulating the design.
Verifying the design by running BFM commands.

Generating the programming file to program the SmartFusion2 device.

Opening the project in SoftConsole from Libero SoC and writing the application code.

©Vo N o o A~

Validating the application design on SmartFusion2 Board.
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Design Requirements

Table 1« Design Requirements

Design Requirements

Description

Hardware Requirements

e SmartFusion2 Evaluation Kit Board or
SmartFusion2 Starter Kit Board - SF2-STARTER-
KIT with M2S050-FGG484 device

* FlashPro4 programmer

Rev C or later

USB Cables

Desktop Computer or Laptop

Any 64-bit Windows Operating System

Software Requirements

Libero SoC vi14
SoftConsole v3.4SP1
Host PC Drivers USB,. Drivers

Project Files
You can download the associated project files for this tutorial from.the Microsemi website:
www.microsemi.com/soc/download/rsc/?f=SmartFusion2 .FIC Tutorial 11p4 DF
The project files include the following:
+ Source
+ Solution
* Programming File
+ Readme file
Refer to the Readme.txt file provided in the design files for the complete directory structure.

Design Description

The design uses the SmartFusion2 SoC FPGA MSS block, one CCC block, on-chip 25/50 MHz RC
oscillator and‘two different slaves in the FPGA fabric. The MSS is configured with FIC_0 and FIC_1
enabled, FIC_O'is configured for the AHBL master interface and FIC_1 is configured for the APB3 master
interface. Choosing this configuration allows the application to access two different types of FPGA fabric
peripheral slaves from two different masters in the MSS. The slaves in the FPGA fabric are
CoreAHBLSRAM .and CoreGPIO. CoreAHBLSRAM is connected to FIC_O through an AHBL bus
interface and CoreGPIO is connected to FIC_1 through an APB3 bus interface. Figure 1 shows the block
diagram of the design. The ARM® Cortex™-M3 processor or any other MSS master can access these
slaves via the FIC blocks. In this design, using BFM models, you will verify the bus read and writes to the
fabric_peripherals from the MSS side. Using a BFM script, you will perform reads and writes to the
CoreAHBLSRAM memory, configure the CoreGPIO block, and set GPIO outputs. In this design, you will
validate the bus read and writes to the CoreAHBLSRAM, and setting the GPIO to blink the LEDs on the
SmartFusion2 Evaluation Kit Board and SmartFusion2 Starter Kit Board.
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SmartFusion2

CLK_BASE
MSS_CCC
/] Reset Controller
MSS
FIC 0 FIC_ 1
AHB Master | | APB Master
25/50 MHz
RC Oscillator
I
v
cCcC

DEV_RST_N
MO M

CoreResetP
- -
< AHB_Lite Bus > < APB3 Bus >
=TT

S0 II
0
GPIO outputs

CoreAHBLSRAM CoreGPIO LEDS
CLK #» CLK

FPGA Fabric

Figure 1 * Block Diagram of the Design

Design Steps

The major steps to run this tutorial are as follows:

Creating a new Libero SoC project for SmartFusion2 SoC FPGA.

Using SmartFusion2 SoC FPGA System Builder to configure the FIC blocks, and clock.
Writing user BFM script to simulate a design.

Simulating the design using BFM Models and ModelSim.

Generate a programming file to program the SmartFusion2 SoC device.

Open the software project in SoftConsole and write the application program.

Run the design on the SmartFusion2 Evaluation Kit Board or SmartFusion2 Starter Kit Board.

N o ok 0N~
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Step 1: Creating a New Libero SoC Project

1. Open Libero SoC design software (Start > Programs > Microsemi Libero SoC 11.4 > Libero
SoC 11.4) or click the Libero SoC shortcut available on your desktop. The version number of the
Libero SoC design software depends on the version that is installed on your PC. You can use
either v11.4 or latest.

2. Select New Project from the Project menu. Enter the information shown below in the New
Project wizard dialog box.

Project Name: SmartFusion2_FIC_Tutorial

Location: Select an appropriate location (for example, D:/Microsemi_prj)
Preferred HDL type: Verilog

Family: SmartFusion2

Die:M2S025T

Package: 484 FBGA

Speed: -1

Core Voltage(V): 1.2

Operating Conditions: COM

PLL Supply Voltage(V): 2.5V

Design Templates and Creators: Select Use Design Tool and select Use System Builder
under core section.

Note: For SmartFusion2 Starter Kit (SF2-STARTER-KIT with M2S050-FGG484 device) Die: M2S050T,
Package: 484 FBGA.
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f G‘ New Project

S

Project

[] Enable Block Creation

Mame: SmartFusion2_FIC_Tutorial
Location: D:\Microsemi_pr
Prefered HOL type: @ verilog (7 WHDL
Description: |
b Edit Tool Profiles...
|
Device
B
Die: M2s5025T hd
package: 434FBGA ¥
Speed: -1 -
Core Voltage (V): 1.2 - Ramp Rate:
QOperating Conditions:
Range Best Typical Waorst
Junction Temperature {C) lCOM > [o 25 a5
Care Voltage (V) ICOM > || 1.280 1,900 1.140
[ System Controller Suspend Mode
PLL Supply Vaoltage (V): 2.5 -
Design Templates and Creators
Use Design Tool
Coré \ersion
|
prpryansy
Shaow only latest version
o) (o
Figure 2 » New Project Wizard Dialog Box
3. Click OK.
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4. Since you selected Use System Builder, as shown in Figure 2, then Enter a name for your

system dialog box is displayed, as shown in Figure 3.

F B
B Systemn Builder m

Enter a name for your system:

SmartFusion2_FIC_Tutorial

Help | ok || Ccancel

Figure 3 * Libero SoC Project Window

5. Enter SmartFusion2_FIC_Tutorial as the name of the system and click OK. The System

Builder window is displayed, as shown in Figure 4.

tem Builder - Device Features ﬂ N | B e
Device Features » » Peripherals __» » Clocks > > Microcontroller » > SECDED > > Security > > Interrupts > » Memory Map
Select the SmartFusion2 features you will be using in your design
Memary Y A N !
1
[] mss External Memory . W A S — 1
1 1
@ MDDR 1 1 H !
Soft Memory Controller (SMC) i DCR Eridge E = E i
’ (5MO) ! [ard | N
[] M55 On-chip Flash Memory { eNvi ) ! H !
1
[] Fabric External DDR. Memory { FDDR ) : : SWITCH : :
1 ]
] ] 1 I
High Speed Serial Interfaces 1 H H |
1 1
[] SERDESIF_0 ] ! i :
1 1
[7] SERDESTF_1 1 1 [Famic ; ! !
1 1
! ! w b
ConZon TP H !
Microcontroller Options i i FAR_CCT } =N H 1
A A 1 1
[] watchdog Timer ! ! |E ; |§ ! :
[ Peripheral DMA 1 H Yol o tal H !
1 1 LY = | !
[T real Time Counter 1 1 = B ] I
i i 3 ;o
1 1 z| FLLH 1
: : e - -0 1
1 1 APB_S PCLK E :
1 1 1
: : PP S PhESS M 1
: : .
: : ; b
: :“u 5 E H :
3
! o oG F o
' R & H '3 E [
1 a o & 2 1 I
1 = 5 1 I
] ! | 4PB H |
j oo ——————— ATROCE | !
i H
1
i H
1 1
D o o e e e e e e e e e e e e e e e e e 1

Figure 4 » SmartFusion2 SoC FPGA System Builder Device Features
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6. Select Next. System Builder- Peripherals page is displayed, as shown in Figure 5 and Figure 6.

[@ system Builder - Periphtrais MRS % n A . [ESEERS)

Device Features » > Peripherals > > Clocks > > Microcontroller » > SECDED > > Security > > Interrupts > > Memory Map »
Select the peripherals and masters for each subsystem

Fabric Slave Cores Subsvstems
e Versien ® MSS FIC 0 - MSS§ Master Subsystem i
L CoreAHBLSRAM  20.113 drag and drop here to add to subsystem
R CoreGPIO 30120
p—— 70100 @ MSS FIC 0 - Fabric Master Subsystem
| CareP WM 11106 drag and drop here to add to subsystem
5 CoreSPI 30156 @ MSS Peripherals
& CoreTimer 11101 Configure Enable Mame
7 CoreUARTapb 522 @ [ |MM UART 0
8 Fabric AMBA Slave 0.0102 [ # MMLUARTD |
i [ |mss nco
@ MSS_2C_1
Fabric Master Cores & £ |mss spLo
Care Version ? MSS_SPL1
1 Fabric AMBA Master 0.0.102 L |msscme
O |mssuce
[0 |mssmac
[0 |msscan

To move 3 peripheral from ane subsystem to another; drag it from its present focation and drop it onto the desired susbsystem.
You cannot drag and drop onto MSS Peripherats.

Masters are in bold and blue.

Figure 5 » SmartFusion2 System Builder Peripherals (M2S025T Device)
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P(-\ System Builder - Peripherals E==)
Device Features » > Peripherals > > Clocks > > Microcontroller > > SECDED > D Security > > Interrupts > > Memory Map »

Select the peripherals and masters for each subsystem

Fabric Slave Cores Subsystems
Core Versian @ MSS FIC 0 - MSS Master Subsystem n
1 CoreAHBLSRAM 20113 drag and drop here to add to subsystem
2 CoreGPIO 30120 > T e =
3 CoreDC 70102 .0 - Fabric Master Subsystem
) CorcFYiHA 41106 drag and drop here to add to subsystem ‘
5 CoreSPI 30156 @ MSS FIC 1 - MSS Master Subsystem
G CoreTimer 11101 drag and drop here to add to subsystem ‘
7 CoreUARTepb  5.22 =
@ MSS FIC 1 - Fabric Master Subsystem
8 Fabric AMBA Slave 0.0102
drag and drop here to add to subsystem ‘
@ MSS Perpherals
Fabric Master Cores. Confiqure Enable Name
N & MM_UART_0
Core Version @
]
1 Fabric AMBA Master 00102 S
-4 MSS_12C_0
o MSS_12C_1
-4 MS5_SPLO
L MS5_SPIL
[0 |msssrs
O |mssuse
[ |msstac
O |mss—can

7o move 2 peripheral from one subsystem (o anothey; ckag it from its present location and drop it onto the desied susbsystem.
You cannot arag and drap ento MSS Perpherals.

Masters are in bold and blue.

Figure 6 » SmartFusion2 System Builder Peripherals (M2S050T Device)

This tutorial uses MSS MMUART peripheral.

7. Select MM_UART_1 for M2S025T device and MM_UART_0 for M2S050T device and uncheck all
the other peripherals.
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This tutorial uses the CoreAHBLSRAM and CoreGPIO IPs. For M2S025T device, drag and drop the
CoreAHBLSRAM and CoreGPIO IPs to MSS FIC_0 - MSS Master Subsystem as shown in

Figure 7.

@ System Builder - Peripherais TG % » A ) [EEE
> Device Features » > Peripherals » > Clocks > > Microcontroller » > SECDED > 2 Security > > Interrupts > > Memory Map >
Select the peripherals and masters for each subsystem

Fabric Slave Cores Sul ems

! Core Version @ MSS FIC 0 - MSS Master Subsystem m
1] CoreAHBLSRAM 20113 Confiqure Quantity Name

2 CoreGPIO 30120 #F [ 1 [coreanBLsramo

3 Corel2C 7.0.102 7 1 |CoreGPIOO
3| CorePWM (1108 @ MSS FIC_0 - Fabric Master Subsyster
5| CoreSPL 30156 I drag and drop here to add to subsystem
& CoreTimer 11101 I—I—
7 CorelARTapb 522 ® . M55 Perppherals
8 Fabric AMBA Slave 0.0.102 Eoufiawe)jfnsble Mg

| &

MM UARTL |

Fabric Master Cores

| Core I Version

1| Fabric AMBA Master 00102

| | oo o | W

7o move 2 peripheral from ane subsystem to another, drag it from its present location and drop it anto the desired sushsystem.
You canniot drag and drap onto MSS Peripherals.

Masters are in bold and blue.

Figure 7 » SmartFusion2 System Builder MSS Peripherals (M2S025T Device)
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For M2S050T device, drag and drop CoreAHBLSRAM to MSS FIC_0 - MSS Master Subsystem and
drag and drop CoreGPIO to MSS FIC_1 - MSS Master Subsystem as shown in Figure 8.

r(-\ System Builder - Peripherals = [ |
Device Features » > Peripherals > » Clocks > > Microcontroller > > SECDED > D Security > > Interrupts  » > Memory Map )
Select the peripherals and masters for each subsyst
Fabric Slave Cores Subsystems

Core

Version

1 CoreAHBLSRAM 20113

MSS FIC_Q - M55 Master Subsystem i
Name
[ COREAHBLSRAM_0

2| CoreGPIO 30120
2 Coretic Tod0 MSS FIC 0 - Fabric Master Subsysten Il
) CorePim 41108 drag and drop here to add to subsystem
5 CoreSPl 30456
6 CoreTimer 11101 @ MSS FIC 1 - MSS Master Subs)
Configure Quantity

7 CoreUARTapb 5.2.2
& Fabric AMBA Slave 0.0.102

CoreGPIO_0

MSS FIC_1 - Fabric Master Subsystem

| drag and drop here to add to subsystem

Fabric Master Cores @ MSS Perpherals

Cor

1 Fabric AMBA Master 0.0.102

EE

Version

&

HOoooo oo

To move 2 peripheral from one subsystam to anothey, drag it Fom its present koeation and drop It onto the desired susbsysten.
You eannot orag and orap onto MSS Perpherals.
Masters are in bold and blue.

Cancel

Figure 8 » SmartFusion2 System Builder MSS Peripherals (M2S050T Device)

8. Configure COREAHBLSRAM..0, by clicking Configure icon as shown in Figure 9.

Subsystems

@ MSS FIC_0 - MSS Master Subsystem
Cunfiqur?\(]_uantitv Marme
& A 1 |coreansisramo

Figure 9 « CoreAHBLSRAM Configuration

12
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Use the settings as shown in Figure 10.

L, Confiuring COREAHBLSRAM_0_0 (COREAHBLSRAM - 2.0.113) lsul o=l st e
i~
Configuration
AHE Data Width: |32 -
AHE Address Width: |32 -
Select SRAM Type g
_ _ N
@ LSRAM | USRAM
LSRAM Depth |
Mumber of bytes of memory: 2045 Q I
N USRAM Depth I
L]
L Mumber of bytes of memory: | 512 \ |
Testbench: |ser -
License:
B RIL @ Obfuscated
cam s

Figure 10 » CoreAHBLSRAM Configuration

9. Click OK after completion of COREAHBLSRAM configuration.

10. Click CoreGPIO Configure icon and use the following settings for SmartFusion2 Evaluation Kit
Board as shown in Figure 11, and keep the rest at default states

*  Number of I/Os: 8 - For SmartFusion2 Evaluation Kit Board

*  Output enable: Internal

¢ Check Fixed Config check box

* /O Type: Output

Note: Number of I/Os: 2 - For SmartFusion2 Starter Kit
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@ Configuring CoreGPIO_0_0 (CoreGPIO - 3.0.120)

Configuration -
Global Configuration T
| APE Data Width: Mumber of Ij0s:
Single-bit interrupt port: Output enable:
o bito =
QOuput on Reset; Fixed Config: 1/O Type: Interrupt Type:
1/O bit 1
Ouput on Reset: Fixed Config: I/O Type: |Output - Interrupt Type: |Disabled
LfObit2 q
Ouput on Reset: Fixed Config: I/O Type: |Output - Interrupt Type:
LjObit 3
Ouput on Reset: Fixed Config: 1/O Type: Interrupt Type:
1/0 bit 4
QOuput on Reset; Fixed Config: 1/O Type: |Output ~ Interrupt Type:
IO bit 5
Quput on Reset: Fixed Config: I/O Type: |Guiput = Interrupt Type:
IfObite
Quput on Reset: Fixed Config: I/O Type: |Output - Interrupt Type:
Ljobit7
Ouput on Reset: Fixed Config: 1/O Type: |Output « Interrupt Type:
/O bit &
: Quput of Reset: |0 A Fixed Config: I/O Type: |Input Interrupt Type: |Disabled
o bite
_Helnp '— ) 0K ] [ Cancel
h
Figure 11 » CoreGPIO Configuration
14 Revision 9
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Note: For SmartFusion2 Starter Kit Board CoreGPIO Configuration window is shown in Figure 12.

&, Configuring CoreGPIO_0_0 (CoreGPIO - 3.0.120) [E=EE ™

Configuration

Global Configuration |

APB Data Width: 32 - Number of I/0s:
Single-bit interrupt port: |Disabled Output enable:

L, |

Ijobito

Ouput on Reset: Fixed Config: IO Type: m Interrupt Type:
I/Obit 1

Ouput on Reset: Fixed Config: IfO Type: m Interrupt Type:
/O bit 2

o) [l

Figure 12 « CoreGPIO Configuration

11. Click OK after completion of CoreGPIQ configuration.

12. Double-click the MM_UART_1 configure icon for M2S025T device and MM_UART_0 configure
icon for M2S050T device.

13. Select 10 from the Connect To drop-downlistand retain the default settings as shown in
Figure 13.

[, Configuring MM.UART_0_0 (SF2MSS_UART .. [FERFERS)

Configuration -

Transmit-Receive

Duplex Mode Full Duplex -
Transmission Mode I

Modem

Ise Modem ||

ConnectTo  |IO

Help oK l [ Cancel

ke - ——

Figure 13  MM_UART Configuration

14. Click OK.
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15. Select Next. System Builder- Clock Settings page is displayed, as shown in Figure 14. Select
the Following options:

» System Clock: Set it to On-chip 25/50 MHz RC Oscillator from the drop down list.
+ M3_CLK: 100 MHz

« MSS APB_0/1 Clocks: 100 MHz

+ Fabric Interface Clocks: 100 MHz

.
() System Buiilder - Clocks P § [EmEE ==

> Device Features » » Peripherals > > Clocks » > Microcontroller » > SECDED > D Security > > Interrupts  » > Memory Map >

Configure clock requirements

Clock | FabricCCC | Chip Osallators

System Clock

50.0 MHz

[0n-chip 25/50 MHz RC Osdilator ] DOR Erdge

1 Cortex-M3 and MSS Main Clock

| M3_CLK = 100.00 MHz 100,000 I

MDDR Clocks
MDDR_CLK =M3_CLK= 1 K

DDR/SMC_FIC_CIK =MDDR_CLK/ |1 K

MSS APE_0/1 Clocks

APB_D_CLK =M3_ClK 100.000
APB_1_CLK —M3_CLK 100,000
Fabric Interface Clocks
FIC_0_CLK —M3cK/ |L 100,000
FIC_10lK =M3_ClK 100.000
Fabric DDR Clocks
FODR_CLK - [0 Mz
FDDR_SUBSYSTEM_CLK =FDDR_CLK/ |1 K
I
o

Figure 14 « SmartFusion2 System Builder Clocks

16. Click Next, the System Builder - Microcontroller Options page is displayed.
+ Leave all the Default Selections.
17. Click Next, the System Builder - SECDED Options page is displayed.
+ Leave all the Default Selections.
18:Click Next, the System Builder - Interrupts Options page is displayed.
« Leave all the Default Selections.
19. Click Next, the System Builder - Memory Map Options page is displayed.
+ Leave all the Default Selections.
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» Figure 15 and Figure 16 shows the address maps for AHBL and APB3 peripherals.

(@ System Builder - MemoryMap 0 00 08~ W ) m A g (=B ]
Device Features » > Peripherals > > Clocks > > Microcontroller » > SECDED > > Security > > Interrupts > > Memory Map »
Memory Map for peripherals attached to the processor
S'Qes'ignﬁ;:rfgh‘gf;“‘(:)’ Assign peripherals to addresses on bus:
CoreAHBLite 0 ( MSS FIC_0 - MSS Master Subsystem ) Addre Peripheral
CoreAPB3_0 ( MSS FIC_1 - MSS Master Subsystem ) 050000000,
030000000, COREAHBLSRAM 0 0:AHBS lavelnterface
=] Clae

Figure 15 » SmartFusion2 System Builder CoreAHBLite Address Map (M2S050T Device)

[(@ system Buitder- Memogiizp TG % T ) m a O [ESEERS)

Memory Map for peripherals attached to the processor

Select Bus to View ar Assign peripherals to addresses on bus:

Device Features » > Peripherals > > Clocks > > Microcontroller » > SECDED > > Security > > Interrupts > > Memory Map »

Assign Peripheral(s)
CoreAHBLite 0 ( M55 FIC_0 - M55 Master Subsystem ) Addre: Peripheral
CoreAPB3 0 (MSSFIC 1 - MSS Master Subsystem ) 0xF0000000,
0:90000000, .
080000000, CO"5P10_0_D:APE_bif
0x70000000

Figure 16 » SmartFusion2 System Builder CoreAPB Address Map

20. Click Finish.
The System Builder will. generate the system based on the selected options.
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The System Builder block is created and added to Libero SoC project, as shown in Figure 17.

_FIC_Tutorial.prix* “S— ~— B —— ~— (e S

Broject File Edt View Design Tools SmortDesign Help

SHaNe0l

Desion Flow 8 x| [ startpage & x | B3 Smrtrusion2_FIC_Tutoria_top™ B X
Smartusion? FIC Tutol_tp ERONER- A 1S = B AAGXE A\ O

Tool

SmartFusion2_FIC_Tutorial_0

FAB_RESET N POWER ON_RESET_N
DEVRST_N MSS_READY

FAB_CCC_PINSE
CoreGPIO_0_0_PINSE

MMUART 0_FABRICE
INT_PINSE

g«

8 x

Fom: SmartFusion2 [Die: M2S0S0T Phg: 896 FBGA Verog

“ M4 puem ||

Figure 17 « SmartFusion2 System Builder Component

To initialize a user design in the SmartFusion2 devices, Microsemi provides a CoreResetP soft Reset
Controller IP. The CoreResetP IP handles a sequence of reset signals in the SmartFusion2 devices.
The CoreResetP does automatically be instantiated and connected by the System Builder. Open the
System Builder component in the Smart Design canvas to view how these blocks are connected.
21. Make the connections for the pins as follows:

* Right-click FAB_RESET_N and select Tie High.

+ To select POWER_ON_RESET_N and MSS_READY pins, hold CTRL key, select pins,
right-click and select Mark Unused.

* Expand INIT_PINS, right-click INIT_DONE and select Mark Unused.
+ Expand FAB_CCC_PINS, right-click FAB_CCC_GLO0 and FAB_CCC_GL1 and select Mark
Unused.

+. Expand CoreGPIO_0_0_PINS,
— Mark the INT[7:0] PINS as unused by right-clicking and selecting Mark Unused.
—Tie the GPIO_IN[7:0] to high by right-clicking and selecting Tie High.
— Promote the GPIO_OUT[7:0] to top by right clicking and selecting Promote to Top

Level.
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After making all necessary connection the system builder block as shown in Figure 18.

() Libero - DAMicrosemi | ion2_FIC_Tutori ion2_FIC Tutorial.prix*

Project File Edit View Design Tools SmartDesign Help

ME W 29™ 0

Design Flow 8 x ‘ StartPage @ X | £ smartFusionz_FIC_Tutorial_top® @ X ‘ =S
SmartFusion2_FIC Tutorial_top G SERID M PP & Q G H ANO
Tool < i
4} Create Design
& System Builder
& Configure M5 = SmartFusion2_FIC_Tutorial_0
B3 Create SmartDesign
Create HDL 4@ rAB RESET N POWER ON RESET_NBPX
DEVRST_N MSS_READY X
%A Create SmartDesign Testbench . MMUART 1 _FADSEI@- FAD
Create HDL Testbench FAB_CCC_ANSEI@ =
4 b Verify Pre-Synthesized Design FAB CCC GLO X
CoreGAIC_0_0 ANSEI@
B simulate INT[T 0] X
4 ) Create Constraints GRO INT0] @ 4
+E 1/0 Constraints GRO_OUT[70] &
€ Timing Constraints INT_FNSEI@
B Floorplan Constraints INT_DONE X
4 ) Implement Design & 4
S Synthesize
4 b Verify Post Synthesis Implementation
B simulate
B Compile i
Design Flow | Design Hierarchy | StmulisHerarchy | Catalog | Fies | | L n - e D

Log y N

€ Errors i, Warnings i} Info

The SmartFusion2 FIC Tutorizl project was created.
@1nzo: Smarcrusions FIC_Tutorial M5S' was successfully generated.

Info: 'SmartFusion2 FIC_Tutorial' was successfully generated.

Info: System Builder successfully generated 'SmartFusion2 FIC Tutorial'. Open Svstem Builder sunmesy for details
@1ozo: pap pin SmarcPusion2 FIC Tuccrial 0:MMUART L FADS' of ‘SmarcFusion2 FIC Tuccrial 0° is sutcmacically sémmected ®o a top-level port.
@1nzo: £10 pin SmarcPusiond_FIC_Turorial 0:DEVRST ' of “SmarcFusiond_FIC_Tutorial _0° is ausomatically confiested to & Sep-level port.

Fam: SmartFusion2 | Die: M25025T |Pkg: 484FBGA | Verilog

Figure 18 * SmartFusion2 System Builder Block
Note: The System Builder Block for SmartFusion2 Starter Kit is shown in Figure 19.

(@ Libero - DAMicrosemi_proSmartFusion?_ FIC_TutoraNSmartFusiond_FIC TUtanaipee

Project File Edit View Design Tools SmartDesign Help.
Sdeeocld &

Fles 8| nepurts @ x| S snrrusoni ric o gt 5 x| s @ x s

e | Bemre M2 R QA HQ BAND

1 designer =

S
a

4 [ simulation
bfmtovec.exe

bimtoveclin
bfmtove_compilelog

bimtovec compietl SmartFusion2_FIC_Tutorial_0 :

ot st st
it 4D FAB RESET N
e e
coreahblite_userth_ahb_masterl.vec DE\/RST N MRST—N
vt s o
e e e
Pt
et et
(1 COREAHBLSRAM_OBF_LIB
@) COREAPB3_LIB

| Ay
it e

)_IN[
GPO_OUT[1:0]
o INT_PINSE]

g INIT_DONE

X [ X XX XX

modelsim.
el MMUART_0_PADS|
wndo
subsystem.bim
tetbim

~@ENMVUART 0_FADS

testvee L
userbfm
vsimwlf
wavedo

3 smartgen =
v

et | Coon | et | Smstiea | s

oo
(Clvesases) @Erors i, vamiogs @ 1o

der successfully generated ,_FIC_Tutorial’. Qpen Svatem
,_FIC_T

lder sumazy for derail

orial/siml Sestbench_presynch_simulation.log’

_FIC_Tutorial \ presynch_siml log' was deleted from project and disk

because it is no longer a valid connection.
XDM2F' does not exist. a
RAD_F2M does not exist.

R —

The connecticn is being dropped fzom the net 'MMUART_O_RXD_F2M' because the pin MMMART

Fom: SmartFuson2

Figure 19 « SmartFusion2 System Builder Block
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22. Click Generate Component icon on the SmartDesign toolbar.

&) smartFusion2_FIC_Tutorial_top & X £ DESIGN_FIRMWARE & X

BER P M 2500 o0 80 & [HC

| Generate Component h

Figure 20 » Generate Component

You can also right-click on the canvas and select Generate Component.

After successful generation of the system, The message "SmartFusion2_FIC_Tutorial_top' was
successfully generated is displayed in the Libero SoC log window if the design was generated
without any errors. The log window is displayed as shown in Figure 21.

Figure 21 » Log Window

Step 2: Modifying User BEM Script for Simulation

You can verify the design by using the BFM master or slave model and a BFM script to drive the
AHBL/APB input of the DUT. This setup allows the BFM to write or read to the AHBL/APB register set
and to verify that the DUT is' behaving as expected.

This step. explains adding BFM commands to the user.bfm file to perform design simulation. For more
information on BFM commands refer to the CoreAMBA BFM User Guide. The user.bfm file is created by
Libero SoC Design'software and is available in the simulation folder of the project files.

Note: Download the project files. Refer to the "Project Files" section on page 4.
1. For SmartFusion2 Evaluation Kit Board, right-click the simulation under project files and select
import files to import the user.bfm file which is located in downloaded design files

(\SmartFusion2_FIC_Tutorial_11p4_DF\Source\For_SF2_Eval_Kit Board\user.bfm) as shown in
Figure 22 or select Files > Import > Others to import the user.bfm file.

20
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2. Click Yes to all to replace the existing user.bfm file.

(@ Libero - DAMicrosemi,  FIC ] 2_FIC Tutorial.prjx*
Project File Edit View Design Tools SmarDesign Help

BETs
S

B [sereese | B3 smartrusion2_Fic_Tutorisl top (3 | Reports [ userbfin (7] | B2 smertrusion2 FIC Tutorial ()
¢ [ component
b [ censtraint (5]
> [ designer
b [ firmware [l ]
ok

Search SmartFi

v [{]_simulation + @ Import Files I
Import Files..
[ smartgen e —
(_J=[} » Computer » Local Disk (D) » Microsemiproj » Smartfusion2 FIC Tutorel » v 4|

T LT SoftConsole

[ stimulus of -
- Organize New folder gz -
b [ synthesis A 2 _ o e
> (3 tooldata x B Desktop. * Mame Date modified Type Size
b [ viewdraw 18 Downloads N
o |/ component 1/21/2014 9:23 AM File folder -

%l Recent Places

constraint 1/21/20149:23 AM File folder | ——
E I designer 122014923 AM  File folder
ol Fbne Il firmuware 22014932 AM  File folder
a Docimens 1 hl 1/17/201410:26 AM  Filefolder
[ oo £ simulation 1202014149 PM File folder
a %:::‘:: |\ smartgen /21/2018 149 P File folder
1. SoftConsole 1/21/2014 9:23 AM File folder
A ™ Computer L stimulus 1/17/201410:26 AM  File folder
N £ Local Disk () 1 synthesis 1/21/20149:33 AM File folder
Il tooldata 121/2010 9488, File folder
0| o locallisk© I, viewdraw 1/21/2014 9:28AM W File folder

€ Network =
or I
Fipsms vI B ioion Filcs (“mem b
Open Cancel
oy e a o4

Design Flow | Design Herarchy | StmulusHierarchy | Catalog | Files

Log N -

Figure 22 « Import bfm file

Note: For SmartFusion2 Starter Kit, import the user.bfm to simulation files from design files.
(\SmartFusion2_FIC_Tutorial_11p4_DF\Source\For_SF2_Starter_Kit_Board\user.bfm)
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3. After importing, double-click the user.bfm file under simulation folder. This opens the user.bfm file
as a new tab in the project window, as shown in Figure 23.

G‘ Libero - D:AMicrosemi_proj\SmartFusion2_FIC_Tutorial\SmartFusion2_FIC_Tutorial.prjx

Project File Edit View Design Tools Help

NEed2e<o

Files g x
StartPage | | Ea SmartFusion2_FIC_Tutorial _top | | userbfm [ |
| component Ee 4 # Syntax:
> [ constraint 54 —————-
> [ designer 6 #
. 7 # memmap regsource name base address;
> [ firmware 83z = e
3 hdl 8 # write width resource name byte_ offset_datas
4 [ simulation 10 & read width resocurce_name byte_o
bfmtovec.exe 11 ¢ readcheck width rescurce_name byte_o
bfmtovec.lin E ?
bfmtovec_compilelog B
bfmtovec_compiletcl 15 $include "subsystem.bfm”
CompileDssBfm.tcl 16
coreahblite_usertb_ahb_master).bfm 17 procedure user_maing
18

coreahblite_usertb_ahb_masterl.vec

< 13 erform subsystem initializatiom routine
coreahblite_usertb_ahb_masterl .bfm L ¥ =

20 # call subsystem indE;

coreahblite_usertb_ahb_masterl.vec il
coreahblite_usertb_include.bfm 22 § add your BFM commands below:

> COREAHBLSRAM_OBF_LIB 23int 1

> [ COREAPB3_LIB = ; int atmp
coreapb3_userth masterbfim 26 //Base Hddressesiof FICO & FICl slaves
coreapb3_userth_mastervec 27 memmap FICO_ZHELRAM BASE 0x30000000;
coregpio_usertb_apb_masterbfm 28 memmap FIC1 APRGPIO BASE 0x70000000;
coregpio_usertb_include.bfm 23
modelsim.ini iheader " AL tFusion? FIC Tutorial**sssin
[T LSy 82 //hefegaing the LSRAM memory
peripheral_init.bfm B37/Data Write to 0x00 location of LSREM

4 presynth Mt write w FICO_AHBLRAM BRSE Ox0 0x12345678;
run.do 33 //Data irice to Ox04 location of LSRAM

36 write 'w FICO_AHRLREM BRSE (x4 OxRARRARRR:

subsystern.bfm
37 //Readcheck at 0x00 location of LSREM

P [F [ 7 [P B 7 [ [P [ [P R [P I IR [ [ [P [P 7 IR [P [P [P 0P [

test.bfm 38 readcheck w FICO_RHBLRAM BASE Ox0 Ox12345678;
testvec B8/ /Readcheck at 0x04 location of LSREM
user.bfm 40 readcheck w FICO_RHBLREM BASE (x4 OxARRRARRA:
vsim.wlf i
wave.do :; /15 z GPT
etting GPIO outputs
[ smartgen ™ 44 yrite b FIC1 APBGPIO BRSE OxR0 0x3;
» [[7 SoftConsole 45 readcheck b FIC1_APBGPIO BASE OxR0 0Ox3;
[ stimulus 45

> [ synthesis 47 return

| Design Flow | Design Hierarchy I Stimmi—ﬁerarch\«I | CEBE| Files |

Figure 23 * user.bfm file
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Generating Testbench

1. From the File menu, select New > HDL Testbench as shown in Figure 24.

Project Edit View Design Tools SmartDesign  Help

D |r_ Mew * |EE  SmartDesign
Open... = £
Jesign Flo P HDL
X Close SmartFusionZ_FIC_Tutorial_top ;g SmartDesign Testbench 1
smartFus B Save Ctrl+5 HDL Testbench I
e, Save SmartFusion2_FIC_Tutorial_top As... SDC (sdc) 1
To
v 4 Import N I/0 Constraint (PDC) File
Link Files N Floorplan Censtraint (PDC) File
v Simulation Script (do)
Export »
WHDL Library »
IE',] Print 3martFusion2_FIC_Tutorial_top Ctrl+P
- LA ALE B bl ¥ IEcor i — o ——

Figure 24 « HDL Testbench
The Create New HDL Testbench File dialog box is displayed.

- B
.| Create New HDL Testbench File @ﬂj

HOL Type

@ Verilog ) VHOL

MName:

testhench] |

Initialize file with standard template
Instantiate Root Design
Setas Active Stimulus i

o) (o

b

Figure 25 + Create New HDL Testbench File

2. Select HDL Type as Verilog or VHDL.
3. Enter Name as testbench in the text box and retain the default settings.
4. Click OK.
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Step 3: Simulating Design Using BFM Models

This section describes how to use the SmartDesign testbench and BFM script file to simulate the design.
1. Add the wave. do file to the SmartFusion2_FIC_Tutorial design simulation folder by clicking File >
Import > Others.

2. Browse to the wave.do file location in the design files folder:
SmartFusion2_FIC_Tutorial_11p4_DF\Source\For_SF2_Eval_Kit_Board. Figure 26 shows the
wave.do file under simulation folder in the Files window.

[® Libero - DAMicrosemi_proj\SmartFusion2_FIC Tutorial\SmartFusion2 FIC Tutorialprix* W

Project  File Edit View Design Tools SmartDesign Help

NEdax@o

Files 8% | Reports & x | B smertfuson2 FIC Tutori top* & X | usenbim (@ % |
| compo?ent 2 B ':I_D 'ﬂ i =D‘D DD Iﬂ'D Q Qq @ i
» [ constraint
» [ designer
> [ firmware
[ hdl

4 [ simulation
bfmtovec.exe
@ bfmtovec.lin

By bfmtovec_compile.log

@ bfmtovec_compile.tel S
By CompileDssBfm.tcl

@ coreahblite_usertb_shb_master0.bfm

@ coreahblite_usertb_shb_masterl.vec * FA[

@ coreahblite_usertb_shb_masterl.bfm DE\/RST N I:E

@ coreahblite_usertb_shb_masterl.vec
@ coreahblite_usertb_shb_master2.bfm
@ coreahblite_usertb_shb_master2.vec
@ coreahblite_usertb_shb_master3.bfm
@ coreahblite_usertb_shb_master3.vec
@ coreahblite_usertb_include.bfm

> [ COREAHBLSRAM_OBF LIB

> [] COREAPB3_LIB
@ coreaph3_usertb_master.bfm
@ coreaph3_userth_master.vec
@ coregpio_usertb_apb_master.bfm
@ coregpio_usertb_include.bfm
@ ENVM_init.mem
@ modelsim.ini
By peripheral_init.bfm

b [J presynth
@ run.do
By subsystem.bfm —_
@ test.bfm
@ test.vec -
@ user.bfm
ﬁ vsim.wlf
@ wave.do

[ smartgen -

| Design F. I Catalog | Design Hierar. Stimulus Hierar. ‘ Files | £l i

Log

gErrurs i, Wamnings i Info

o 'SmartFusien24FIC Tutorial' was successfully generated.

OInfD: Sysrem Builder successfully generated 'SmartFusion2 FIC Tutorial'. Open Svatem Builder summary for details
Delecing 'DifMicrosemi proj/SmartFusion2 FIC Tutorial/simulation/testbench presynth simulation.log’

Info: The file 'D:\Microsemi proj\SmartFusion2 FIC Tutoriall\simulation\testbench presynth simulation.leg' wa3 deleted fror

m

Info: Diseonnecting pin 'GPIO _OUT' from net 'GPIO OUT' because it is no longer a valid connection.
Info: The connection is being dropped from the net '"MMUZRT 0_TXD M2F' because the pin "MMUART 0 _TXD M2F' does not exist.
Infos The connection is being dropped from the net 'MMUZRT 0 _RXD F2M' because the pin "MMUART 0 _RXD F2M' does not exist.

Figure 26  wave-do File

Note: For SmartFusion2 Starter Kit board, browse to the wave. do file located in the downloaded design
files folder: SmartFusion2_FIC_Tutorial_11p4_DF\Source\For_SF2_Starter_Kit_Board.
3. Set up the simulation environment as follows:
Select Project > Project Settings. On the Project Settings window, under Simulation Options,
select DO File to change the simulation run time. Enter 50us in the Simulation Runtime field, as
shown in Figure 27.

24
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Design Flow

Testbench module name:  testbench

-I Top level instance name:  <top>_0

4
| DO File
averormes,

Vsim commands
4 Simulation Libraries
SmartFusion2
COREAHBLITE_LIB
COREAHBLSRAM..
COREAPB3_LIB

|| Generate VD fie

VCD file name: paower.vecd

[ verilog 2001
[ system verilag

[T] vHDL 2008

User defined DO file:

DO command parameters:

Select Verilog Language Syntax .

Select VHDL Language Syntax T

(:\ Project Settings l PR X
Device .
Use automatic DO file
Device /O Settings 9 Saxs
Preferred HDL Type | Simulation runtime: 50us|

Close

Figure 27 « Project S

ettings — Do File

4. Save the Do File configuration, this.can be done by clicking the Save.
5. Select Waveforms under Simulation Options as shown in Figure 28 on page 26:

a. Select Include Do file.

b. Select Log all signals in the design check box.
c. Click Close to close the Project settings dialog box.
d. Select Save when prompted to save the changes.
Note: You canalso add ports or signals of interest in the ModelSim software.
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G‘ Project Settings

Device Fl
I [¥] Include DO fil |
Device /O Settings o :

Preferred HDL Type wave.do E
Design Flow
4 Simulation Options Digplay waveforms for [mp_level testhench ']
Dol

Waveforms I Log all signals in the design I

4 Simulation Libraries
SmartFusion2
COREAHBLITE_LIB
COREAHBLSRAM..
COREAPB3_LIB

Restore Defaults

Close:

Figure 28 ¢ Project Settings — Waveforms

6. Select the Design Flow tab in the project window.
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7. Expand the Verify Pre-Synthesized Design, as shown in Figure 29. Double-click Simulate to
invoke ModelSim. ModelSim will be invoked and load the design. Alternatively, you can right-click

the Simulate and select Open Interactively.

Diesign Flow
—ph

SmartFusion2_FIC_Tutorial_top

Tool

4 ! b Create Design

&5 System Builder
v &5 Configure MSS

Create HDL

B3 Create SmartDesign

%4 Create SmartDesign Testbench
Create HDL TestBench
& View/Configure Firmware Cores

[

. Simulate

¥ Verify Pre-Synthesized Design

)
|

Lreate Constraints
"E IO Constraints

[

[

4 Implement Design

v S Synthesize
4
. Simulate
v iz Compile

95 Place and Route
# Edit Canstraints

<

[

. Simulate
(& Verify Timing
o} Verify Power

Dl _n B Fad

+{} Configure Flash*Freeze

"'E /0 Constraints

d) Timing Constraints

% Flzorplan Constraints
@°'»  Verify Post Layout Implementation

*L| Generate Back Annotated Files

4 b Edit Design Hardware Configuration

i

a constraintiic\SmartFusionZ _FIC Tutorial_top.io.pdc
d) Timing Constraints
a synthesis\SmartFusion2 _FC Tutorial_top_sdc.sdc
% Floorplan Constraints

¥ VerifyMPost-Synthesis Iimplementation

»

m

Design Flow

Design Hierarchy | Stimulus Hierarchy

Catalog | Files |

Figure 29 * Design Flow — Verify Pre-Synthesized Design
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8. Maximize the ModelSim Transcript window to see the BFM commands execution. Make sure
that there are no errors. Figure 30 shows the ModelSim Transcript window.

File Edit VYiew Bookmarks Window Help
f A Transcript

¥ Time: 43650010.0pa! Instance: testbench.SmartFusiDnE_fTE:EutDrial_pr_ﬂ.Smartfﬁg- -
ion2 FIC Tutorial 0.COREAHBLSEZM 0 0.U SramCtrlIf.genblkl.byte 3.blockl

# BFM: Data Write 30000000 12345&78

# BFM:32808:readcheck w 30000004 aaaaaaaa at 43700 ns

# ** Warning: Port A Write to and Port B Read from the same address at the same €1
me. Read data from conflicting address is unknown

# Time: 43710010.0ps! Instance: teatbench.3SmartFusion? FIC Tutorial top 0 .3martFus
ion2 FIC Tutorial 0.COREAHBLSEZM 0 0.U SramCtrlIf.genblkl.byte 0.Blockd

# ** Warning: Port A Write to and Port B Read from the sameladdreéssdat the same ti
me. Read data from conflicting address is unknown

# Time: 43710010.0ps! Instance: teatbench.SmartFusion? FIC Tutorial top 0.5martFus
ion2 FIC Tutorial 0.COREAHBLSEZM 0 0.U SramCtrlIf.genblklibywte 1.Bleckl

# ** Warning: Port A Write to and Port B Read from the samg address at the same ti
me. Read data from conflicting address is unknown

# Time: 43710010.0ps! Instance: teatbench.3SmartFusionZdFIC, Tutorial top 0.3martFus
ion2 FIC Tutorial O.COREAHBLSEZM 0 0.U SramCtrlIf.genbl¥kl.bBwte Z2.blockl

# ** Warning: Port A Write to and Port B Readpirom the same address at the same ti
me. Read data from conflicting address is ulknown

# Time: 43710010.0ps! Instance: teatbench.SmartFusion? FIC Tutorial top 0.35martFus
ion2 FIC Tutorial O0.COREAHBLSEZM 0 0.U/SramCtrlIf.genblkl.byte 3.blockl

BFM: Data Write 30000004 maaaaaaa

BFM:32812:write b 700000a0 000000ak at 43760 ns

BFM: Data Read 30000000 12345678 MRSK:fEEfffff at 43810.010000ns
BFM:32813:readcheck b 70000080 0004000ak a€ 43820 ns

BFM: Data Read 30000004 amaa@aass MASKIFfffffff at 43870.010000ns

BFM:32815:return

BFM:24:return

BFM: Data Write 70080020 000000ab

BFM: Data Read 700000a0 000000ak MASK:000000ff at 44000.010000ns

F T T T R TR TR R TN

B MSS BFM Sim@lation Campletegs 12 Inatructions — NO EERORS

Figure 30 * ModelSim Transcript Window — BFM Commands
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9. After successful BFM simulation, observe the ModelSim waveform window for the read and write

bus transactions to the fabric peripherals, as shown in Figure 31. Notice the result of GPIO
configuration BFM commands in GPIO states.

e — O — T —

T T T ————
File Edit View Add Format Tools Bookmarks Window Help
= B
S8 sRBO[0-KE || SHARD

|Btes F molEBBEe HHe || tatitas
36~ 96 B | Search ene || qaeban| | I W
S —

I ———

.. [testbench/SmartFusion2_ FIC Tutorial_top_0/SmartFusion2_FIC Tutorial_0/CCC_0LLOCK =l
_0/SmartFusion2_FIC Tutoria_0/CCC_0/Glo r |

| top_0/SmartFusion?2_FIC_Tutoral 0JCORERESETP _ORESET N_F2M i 7 o 7 e - ;

| top_0/SmartFusin2.FIC_Tutorial_0/CoreAHBLite_OHCLK

|B-%-2@ 3| [\ w2 B || L E TR S

o
10101011

GPIO Qutputs

L —r |
| KT sl . —

44555938943 s to 462904633%€

/
- T
< %D 30em

Figure 31 » Design Simulation Waveforms

Quit the ModelSim simulator by selecting File > Quit.
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Step 4: Generating Programming File

1. Double-click Edit Constraints > 1/O Constraints in the Design Flow window as shown in
Figure 32. The I/0 Editor window is displayed after completing Synthesize and Compile.

SmartFusion2_FIC_Tutorial_top a Q ﬁ'
.

Tool =i

4 p Create Design
&5 System Builder
v &5 Configure MSS
B3 Create SmartDesign
Create HDL '
24 Create SmartDesign Testbench
Create HDL TestBench 1
& View/Configure Firmware Cores
¥ Verify Pre-Synthesized Design
. Simulate
Create Constraints
"E I/O Constraints
a constrainthic\SmartFusionZ_FIC_Tutorial_top.io.pdc
('1) Timing Constraints
a synthesis\SmartFusion2_FIC_Tutorial_top_sdc.sdc
Q Floorplan Constraints
4 b Implement Design
v S Synthesize
4 b Verify PostSyntliesis Implementation
. Simulate
v i Compile
*[| Configure Flash*Freeze
v “45 Place and Route
4 »_Edit Constraints
[== 1O Constraints
(3 Timing Constraints
Q Fleorplan Constraints
4 b Verify Post Layout Implementation
*L| Generate Back Annotated Files
. Simulate
(& Verify Timing
o} Verify Power

4 p Edit Design Hardware Configuration

be I .Y . Fad x x LT i

[
L W [
m

[

Design Flow | Design Hierarchy I Stimulus Hierarchy Catalog I Files |

Figure 32 + 1/0 Constraints
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2. The I/O Editor is displayed. Make the pin assignments as shown in Table 2.
Table 2 « Port to Pin Mapping

Pin Name Pin Number
GPIO_OUTI0] E1
GPIO_OUT[1] F4
GPIO_OUTI[2] F3
GPIO_OUTI3] G7
GPIO_OUTI[4] H7
GPIO_OUTI[5] J6
GPIO_OUTI6] H6
GPIO_OUTI7] H5

After the pins have been assigned, the I/O Editor is displayed.as shown in Figure 33.

[ *= /0 Editor - SmartFusion2_FIC_Tutorial top - , \‘ o
Eile Edit View Tools Help
W DD S
Ports ‘ Package Fins | Package Viewer |
Pod Mame | 1 Direction [ 140 Standard [+ Pin Mumber | Laocked |
1 DEVRST_M Input -- F15
2 GPIC_QUTIO] Output LYCMO525 El
E GPIO_OUT[1] Output LYCMOS525 F4
4 GPIO_OUT[Z] Qutput LMCMOS525 F3
5 GPIO_QUT[3] Qutput LVCMO525 )
& GPIC_OUT[4] Output LYCMOS525 H7
7 GPIO_OUT[S] Output LWVCMO525 Ja
g GPICO_OUT[E] Cutput LYCMO525 Hi
g GPIG_QUTIY] Output LYCMO525 H5
10 < WIMUART 1_RXD Input LYCMOS525 G18
11 MMUART 1_TXD Output LWVCMO525 H19

Figure 33 < 1/O Editor

Note: <Pin assignments for the SmartFusion2 Starter Kit Board is shown in Table 3.
Table 3 « Port to Pin Mapping

Pin Name Pin Number
GPIO_OUTI0] AB18
GPIO_OUT[1] P1

These pin assignments are for connecting below on the SmartFusion2 Evaluation Kit:
— GPIO_OUTI0] to GPIO_OUT[7] for LEDs
— MMUART to USB

3. After Updating the I/O editor, Click Commit and Check.
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4. Close I/O editor.

5. Click Generate Bitstream as shown in Figure 34 to complete place and route, verify timing, and
generating the programming file.

Jesign Flow

SmartFusion2_FIC_Tutorial_top

| Generate Bitstream I

Tool

Figure 34 + Generate Bitstream

Step 5: Programming the SmartFusion2 Board Using Flash
Pro

Before proceed with programming device, ensure that FlashPro4 programmer.is properly connected to
the Flash Pro Header of board. Use the following details to ensure the correct jumper settings. Refer to
the SmartFusion2 Starter Kit User Guide and theSmartFusion2 SoC FPGA Evaluation Kit User Guide for
additional information.

Jumper Settings for SmartFusion2 Evaluation Kit Board

Connect the jumpers on the SmartFusion2 SoC FPGA EvaluationKit, as shown in Table 4. While making
the jumper connections the power supply switch SW7'on.the board should be in OFF position.

Table 4 « Jumper settings for Evaluation Kit Board

Jumper Pin (from) Pin (to)

J3, J8 1 (default) 2

Jumper Settings for SmartFusion2 Starter Kit Board

Connect the jumpers on the SmartFusion2 SoC FPGA Starter Kit, as shown in Table 5.
Table 5 « Jumper settings for Development Kit Board

Designation Name Settings Description

JP1 VCC3 1-2 Closed The +3.3 V voltage from the output of the U2 LDO
regulator is applied to the SOM and to the SOM-BSB-
EXT.

3-4 open The +3.3 V voltages from the output of the U2 LDO
regulator is not applied to the D1 double diode ORing
scheme.

JP2 JTAG Mode Selection 1-2 Open The SmartFusion2 JTAG controller is in the FPGA
programming mode.

3-4 Closed The settings of jumpers 3-4 do not affect M2S-SOM.

JP3 VCC5 1-3 open The +3.3 V LDO regulator is powered from the +5V USB
2-4 closed power through the P1 mini USB connector.
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Programming the Device

Double-click the Run PROGRAM Action under Program Design in the Design Flow window as shown
in Figure 35 to program the SmartFusion2 SoC device.

Design Flow

SmartFusion2_FIC_Tutorial_top

(=]

4

-

¥ Verify Post-Synthesis Implementation
. Simulate
B3 Compile
+| Configure Flash*Freeze
9,3 Place and Route
» Edit Constraints
"E /0 Constraints
d) Timing Constraints
Q Floorplan Constraints
» Verify Post Layout Implementation
+| Generate Back Annotated Files
. Simulate
B Verify Timing
(o} Verify Power
Edit Design Hardware Configuration
I*l Programming Connectivity and Interface
& Programmer Settings
i Device /O States During Programiming
Configure Security and Programming Optidns
4 Configure User Programming Data
W‘ Configure Programming Recovery
@ Configure Security
W‘ Update eNVM Memory Content
Program Desiggi
W‘ Configure Bitstream
@‘ Generate Bitstream

B n PROGRAM Action

Debug Design
Handoff Design for Production
Handoff Desighn for Firmware Development

Tool
v
v
(74 4
v
<

il |

2

m

| Design Flow | DeHHierardw—l- Stimulus Hierarchy I Catalog I Files |

Figure 35 * Run PROGRAM Action
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Figure 36 shows the board setup for running the application design on the SmartFusion2 Evaluation Kit
board.

e

PEEREEEE LT EEPERERERERE
T ARLELLLLLLLLLLEELEEL LR

Figure 36 « SmartFusion2 SoC FPGA Evaluation Kit Setup
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Figure 37 shows the board setup for running the application design on the SmartFusion2 Starter Kit
board.

60L061VL

o
53

.y .05 ®
U9 0l

Wy W
oy oy

Figure 37 » SmartFusion2 SoC FPGA Starter Kit Setup

Note: Do not interrupt the programming sequence; it may damage the device or the programmer. If you
face any problems, contact Microsemi Tech Support at soc_tech@microsemi.com.
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Step 6: Building the Software Application through
SoftConsole

1. Click Handoff Design for Firmware Development > Export Firmware in the Design Flow
window.

2. Right-click and select Export Firmware... as shown in Figure 38. The Export Firmware dialog
box is displayed.

Design Flow

SmartFusion2_FIC_Tutorial_top

Tool i
+L| Generate Back Annotated Files
. Simulate
& Verify Timing
(o} Verify Power
Edit Design Hardware Configuration
I*l Programming Connectivity and Interface
an Programmer Settings
s Device /O States During Programming

[
-

[
-

Configure Security and Programming Options
$# Configure User Programming Data

@‘ Configure Programming Recovery
Configure Security

@‘ Update eNVM Memory Content

Program Design

@‘ Configure Bitstream

@‘ Generate Bitstream

U Run PROGRAM Action

Debug Design

Handoff Design for Prag@uction

Handoff Design forkitmware Development

[N
-

v v
m

[N
|

¢ Configure Firmware Cores
" Export Firmware

Export Firmware... I B -

4 | [ 3
[ y 4 Help

Design Flow | Design Hierarchy—{ TS P ErErTy =] ey | Files |

Figure 38 » Handoff Design for Firmware Development

3. Enter the below information in the Export Firmware dialog box.

(5] Export Firmware % g e Sesmm— e -

Location: | D:Microsemi_prj\SmartFusion2_FIC_Tutorial |
|Creahe project |SoftConsole3.4 - I

o) [

Figure 39 * Export Firmware

— Browse to the Location such as <C:\ or
D:\Microsemi_prj\SmartFusion2_FIC_Tutorial_11p4_DF>.

— Select the Create project check box and select SoftConsole3.4 from the drop-down list.
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4. Click OK. The Information dialog box is displayed as in Figure 40.

J— |

7| Information

irmware project was successfully exported to 'D:\Microsemi_prj\SmartFusion2_FIC_Tutorial'.

Figure 40 * Export Firmware-Information

5. Click OK.
6. Click Start > Programs > Microsemi SoftConsole v3.4 > Microsemi SoftConsole IDE v3.4 or
double-click the shortcut icon on your desktop. The SoftConsole Workspace Launcher is

displayed as shown in Figure 41.

SC Workspace Launcher i g S S supting et oy (E3)

Select a workspace

Microsemi SoftConsole IDE v3.4 stores your projects in a folder called a workspace.
Choose a workspace folder to use for this session.

Workspace: n2_FIC_Tutorial\SoftConsole\SmartFusion2_FIC_Tutorial_MS5_CM3\projects Browse...

[ Use this as the default and do not ask again

oK ] ’ Cancel

Figure 41 - SoftConsole Workspace Launcher
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7. Navigate to the SoftConsole folder and select projects folder as shown in Figure 42.

SC Workspace Launcher — =

Select a workspaceg Select Workspace Directory M

Microsemi SoftConsole

Choose a workspace fo Select the workspace directory to use,

Workspace:  C:\SmartF > | designer s i\]
= firmware
J hdl
> . simulation

. smartgen

4 | SoftConsole

[ Use this as the defaulf|

4 SmartFusion2 FIC Tutorial MS5 CM3
4| | projects
- SmartFusion2_FIC_Tutorial_MS5_CM3_app _| l
> . SmartFusion2_FIC_Tutorial_MS55_CM3_hw_platform 1
. stimulus
> L synthesis J
.. tooldata I
> SmartFusion2_FIC_Tutorial_DF i

Folder: projects

(ko] o ]

Figure 42 + Select Workspace Directory
8. Click OK.
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The SoftConsole IDE window is displayed as shown in Figure 43.

r S ——
§C C/C++ - Welcome to Microsemi SoftConscle IDE v3.4 - Microsemi SoftConsole IDE v3.4

=) |

File Edit Source Refactor MNavigate Search Project RBun  Window Help
o 9 s E S G AE H O QU @S (e
] - o v X - -
[ Project Explorer &2 =0 Welcome 3 = 0|[5= outli 52 Mak | = O
] P
= % 7 || Microsemi SoftConsole IDE v3.4 e riaa e

| »

SoftConsole is a free software development environment

enabling the rapid production of C and C++ executables for processors
available for use in Microsemi devices. Creating a project inside SoftConscle
lets you write software that is immediately compiled into a usable binary.

(=) Starta Project
To begin your work, click File > New > C Project
Give your project a name, and select a toolchain if you are going to
be compiling for a target other than the default choice of the Microsemi Corte
Then click Finish. I

Add an initial source file with File > New > Source File

Add codeto it, and click the Build All icon.

4 [ r ]
E:_\ Problems &3 E.Taskq = Console} = Proper‘tiaﬂ ¥ =0
0 items
Description E Resodrce Path Location  Type
d - . U v
&
n}
L. T—

Figure 43 » SoftConsole IDE
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9. Import the existing project into workspace as shown in Figure 44.

SC C/C++ - Welcome to Microsemi SoftConsole IDE v3.4 - Microsemi SoftConsole IDEv34 SRRCEL X
File Edit Source Refactor Mavigste Search Project Run Window Help
- ] 4w 5% v [ v (% - - - P ) N ol S E (fg o/C+
. B . SR € Import [ [ 5 |
s€ Import B %
[ Project Explorer &2 = | Select
) G|| Creste new projects from an archive file or directory. Import Projects —
Select a directory to search for eisting Eclipse projects.
-
Select an import source:
—_— type filter text @ Select roct directory: [ Bogp. |
New »
1 4 (= General () Select archive file: Browse...
{2y Import... [T, ArchiveFile ’
oA ||Exporte L Bxisting Projects into Workspace 2 Projects: Browse For Folder
(), File System
&7 Refresh 3 =L preferences Select root directory of the projects to import
. B C/CH+
s & s
p hl -
> (& Run/Debug
. G Team simulation
smartgen
4 | SoftConsole
4| SmartFusion2_FIC Tutorial_MSS_CMVE.
4| | projects|
|| Copy projects into workspace .metadata
Working sets SmartFusion2 FIC_Tutoffal MSS_CM3_app
SmartFusion2_FIC_Tutorial MSS_CM3_hw_platf
[] Add project to working sets Ry - - R - -peerm
J stimulus L
b L synthesis
)
@ < Back Next > tooldata
> @ Projects
o 0 items selected | > £ DVD RW Drive (E) =
® | Sl oo

Figure 44 - Importing the Existing Project into Workspace

a. Right-click the Project Explorer tab and select Import.... The Import dialog box is displayed.

b. Select Existing Project into Workspace under General folder and click Next. The Import
Projects dialog box is displayed.

c. Click Browse to navigate to the existing project. The Browse for Folder dialog box is
displayed.

d. Navigate to the SoftConsole folder and select projects folder as shown in Figure 44.
e. Click OK and then click Finish.
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The SoftConsole Perspective displays similar to Figure 45.

SC C/C++ - Welcome to Microsemi SoftConscle IDE v3.4 - Microsemi SoftConsole IDE v3.4 oS S

File Edit Source Refactor Mavigate Search Project Run  Window Help

i b} = E-avd-6- B -0 A S P 5 (g Crce+
[P Project Explarer 52 = % T 7 0B Welcome i3 = B|[5% outi 2 @ Mak | = O
= SmartFusion2_FIC_Tutorial_MS5_CM3_app Microsemi SoftConsole IDE v3 4 An outline is not available.

=% SmartFusion2_FIC_Tutorial_MS5_C M3_hw_platform

SoftConsole is a free software development environment

enabling the rapid production of C and C++ executables for processors
available for use in Microsemi devices. Creating a project inside SoftConscole
lets you write software that is immediately compiled into a usable binary.

=+ Start a Project
To begin your work, click File > New > C Project
Give your project a name, and select a toolchain if you are going to
be compiling for a target other than the default choice of the Microsemi Cortex-M3. £
Then click Finish.

Add an initial source file with File > New > Source File ”’

Add code to it, and click the Build All icon.

= Existing Code | |||
fou can alse import an existing source tree using F
File > Import...
and click
General > File System

Lf._ Problems % ¥ Tasks| B Console| & Properties Hamed
0 items |
Description = Resource Path Location  Type

B

Figure 45 « SoftConsole Perspective

10. Go to the source folder in the downloaded design files folder, copy the code from the
Source_eval.c file. In SoftConsole editor under SmartFusion2_FIC_Tutorial_MSS_CM3_app
project, place the copied code in the main.c file and delete the existing code.

Note: For the SmartFusion2 Starter Kit Board, the Code provided in source_starter.c in source files.

11. Copy the CoreGPIO folder from
\SmartFusion2_FIC_Tutorial_11p4_DF\Source\For_SF2_Eval_Kit_Board\ and paste it in
\SoftConsole\SmartFusion2_FIC_Tutorial_MSS_CM3\projects\SmartFusion2_FIC_Tutorial_MSS
_CM3_hw_platform\drivers location.
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12. Select Project > Clean to perform a clean build. Accept the default settings in the clean dialog
box and click OK as shown in Figure 46.

5C Clean [ = ﬂh,l

Clean will discard all build problems and built states, The next time a build occurs
the projects will be rebuilt from scratch.,

@ Clean all projects () Clean projects selected below

[ = SrnartFusion2_FIC_Tutorial M55 CM3_app
[ e SrartFusion2_FIC_Tutorial M55 CM3_hw_platform

Start a build immediately
(@ Build the entire workspace

() Build only the selected projects

| ok || cancel

L

Figure 46 + Clean and Build window

13. Ensure that there are.no errors and warnings. Use next steps to configure the Serial Terminal.
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Step 7: Configuring the Serial Terminal Emulation Program

Prior to running the application program, you need to configure the terminal emulator program on your
PC. Perform the following steps to use the SmartFusion2 Evaluation Kit Board or SmartFusion2 Starter
Kit Board:
1. Connect one end of the USB mini-B cable to the respective USB connector provided on the
SmartFusion2 Board.

2. Connect the other end of the USB cable to the host PC. Make sure that the USB to UART bridge
drivers are automatically detected, as shown in Figure 47 and Figure 48.

=4 Device Manager (TS | R’
File Action View Help
&= | E HE & 2 &S -\ N
4T e USB Serial Port (COM11) Properties @\
- g8 Computer
> ep Disk drives General | Port Settings | Driver | Details |
b & Display adapters
b - DVD/CD-ROM drives - 1USE Serial Port {COM11)
>-£§ Huran Interface Devices e
o g IDE ATASATAPI controllers ; ]
.. Junge Device type: Parts (COM & LPT)
» 2= Keyboards Manufacturer: FTDI
j> --E! Mice and other pointing devices Location: on USE Seral Converter D
> ‘__- Monitors
» -%F Network adapters Device status
4 --f? Ports (COM & LPT) [This device is#oiking propery. o

1
T3 USE Serial Port (COM11)

eral Fo
5" USB Serial Port (COM3) Il
D Processors

-% Sound, video and game controllers
JM Systemn devices

b - E Universal Serial Bus controllers

[ ok || Cancel

Figure 47 * SmartFusion2 Evaluation Kit USB Serial Port Drivers
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=4 Device Manager : ‘:;_EI 2
File Action View Help
ol AN NERN 7 B AN X
. r
4 g WI64-Aitha$ USE Serial Port (COM21) Properties e
{8 Computer
- Disk drives General |F‘ort Settings | Driver I Detailsl
» By Display adapters
b o DVD/CD-ROM drives USB Serial Port (COM21)
P e
[ % Human Interface Devices R
b= iDE ATASATAPI controllers T Ports (COM & LPT)
I unge
5 Keyboards Manufacturer: FTDI
Mice and other peinting devices Location: on USB Sedal Converter
| Menitors
i ¥ Network adapters Device status
I3 Other devices [This device is working propery. A I

¢ lu[lp CDC Serial
b B Portable Devices
415" Ports (COM & LPT)

..... YT Communications Port (COML

Processors

e

-% Sound, video and game controllers

M| Systern devices

[~ i Universal Serial Bus controllers

[ ok || Cancd |

Figure 48 « SmartFusion2 Starter Kit USB Serial Port Drivers
3. If USB to UART bridge drivers are not installed, download and install the drivers from
www.microsemi.com/soc/documents/CDM_2.08.24_WHQL_Certified.zip.

4. Start a terminal emulator program with the baud rate set to 57600, 8 data bits, 1 stop bit, no parity,
and no flow control.

5. Refer to the Configuring Serial Terminal Emulation Programs Tutorial for configuring
HyperTerminal, Tera Term, and PuTTY.

44 Revision 9


http://www.microsemi.com/soc/documents/CDM_2.08.24_WHQL_Certified.zip
http://www.microsemi.com/soc/documents/Configuring_Serial_Terminal_Emulation_Programs.pdf

& Microsemi

Interfacing User Logic with the Microcontroller Subsystem

Step 8: Debugging the Application Project using SoftConsole

Use the following steps to debug the application project using SoftConsole:
1. Select SmartFusion2_FIC_Tutorial_MSS_CM3_app in Project Explorer.
2. Select the Debug Configurations from the Run menu of the SoftConsole. The Debug dialog is
displayed.
3. Double-click on Microsemi Cortex-M3 Target to display an image similar to Figure 49.

SC Debug Cenfigurations

Create. manage. and run configurations

YE X | = Hn o«
= ] Name:  SmartFusion2_FIC_Tutorial_MS5_CM3_app Debug
type filter text - - By
[Z] Main i? Debugger | [l Commands 'ly Source| = Commen
= Launch Group — n Ny
SC Microsemi Coref051s Target Project (optional):
S0 McinsEmi TPl amet SmartFusion2_FIC_Tutorial_MS55_CM3_app

SC Microsemi Cortex-Ml Target
la SC Microsemi Cortex-M3 Target
SC SmartFusion2_FIC Tutorial M55_CM3_app Debug Debug!SmartFusion2_FIC_Tutorizl_MSS_CM3_app Search Plquct...] [ Browse... ]

C/C++ Application:

[ Application console

Filter matched 6 of 9 items

@) Debug ] l Close

Figure 49 « Debug Window
4. Confirm that the following appear on the Main tab in the Debug window:
» Name: SmartFusion2_FIC_Tutorial_MSS_CM3_app Debug
» Project: SmartFusion2_FIC_Tutorial_MSS_CM3_app
»  C/C++ Application: DebugSmartFusion2_FIC_Tutorial_ CM3_app
5. Click Apply and Debug.
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6. Click Yes, when prompted for Confirm Perspective Switch. This displays the debug view mode
as shown in Figure 50.

SC Confirm Perspective Switch 2

This kind of launch is associated with the Debug perspective,

This Debug perspective is designed to support application debugging. It
incorporates views for displaying the debug stack, variables and breakpoint
rmanagement.

Do you want to open this perspective now?

[ Remermber my decision

-

Figure 50 * Confirm Perspective Switch

7. Debug Perspective is similar as shown Figure 51.

- .
SC Debug - SmartFusion2_FIC Tutorial MSS_CM3_app/main.c - Microsemi SoftConsole IDE v3.4 v i [E=AEEE )

Eile Edit Source Refactor Navigate Search Project Run Window Help

D-Halm i $-0-%- i®- oo~ & [ Debug | T C/ce+

%5 Debug 22 | 55 LR = ‘ i = ‘ e T g E](ﬁ‘k yafiher > P Breakpoints | 41ii Registers | = Modules = m]
SC SmartFusion2_FIC_Tutorial_MS55__M3_app Uebug [Microsemi Cortex-M3 Target] = 3 ‘ e_%; Ef
5:.) Embedded GDE (1/17/14 1:51 PM) (Suspended) <The program is not being run.> 4
o Thread [0] (Suspended)
pl C\Microsemi\Libero_v11.1\SoftConsele\Sourcery-G++\bin\arm-none-eabi-gdb.exe (L/A7/14 .
SC SmartFusion2_FIC_Tutorial_MS55_CM3_app Debug [Micresemi Cortex-M3 Target]
Embedded GDE (1/17/14 1:56 PM) (Suspended) H
o Thread [1] (Suspended)
= 1 main() d\test_es\smartfusion2_fic_tutorial\softconsole\smartfusion2_fic_tuternial_mss
pl C\Microsemi\Libero_v11.1\SoftConsele\Sourcery-G++\bin\arm-neneeabi-gdb.exe [1/17/14

Mame Value
(= n_buff 0x2000fff4

€ 1 I r | b

I¢] main.c &2 . [E] -1 <symbol is not available> = O|[ 8 Outline 2 1% 8
=k z
1 - = drivers/mss_uart/mss_uart.h
22int maimf{) = &l drivers/CoreGPIO/core_gpio.h
B [ 1 4 b = stdinth

B Consale &2 éTa;k; B_( Problems o Executables G Memory | 5] Eﬂl sﬁ;.ﬂ = | | maf
SmartFusion2_FIC_Tutorial_MSS_CM3_app Debug [Microsemi Cortex-M3 Target] C:\MicrosemitLibero_v11.1\SoftConsole\Sourcery-G++\bin\arm-none-eabi-gdb.exe (1/17/14 1:56 PM)

arm-noncSSSBRSSPYI te: End 4ESprogramming

Start address 0x188, load Size 7700

Transfer rate: 1 KB/sec,/62 bytes/write.

Temporary breakpaint Afat 0x326: file ../main.c, line 27.

Note: automatically using hardware breakpoints for read-only addresses.
cont

Temporary breakpoint 1, main () at ../main.c:27
27 M35 UART init{ &g mss uart0,MS5 UART 57600 BAUD,MSS UART DATA 8 BITS | MS5 UART NO PARITY | MSS UART CNE STOP BIT }: [

q | 1

o® Writable Smart Insert 27:1

Figure 51 » Debug Perspective

8. Run the application by clicking Run > Resume or click Run icon on the SoftConsole toolbar.
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The Application options along with the greeting message are displayed in the terminal program

window as shown in Figure 52.

L COM28:37600baud - Tera Term VT

=EI>)

Eile Edit Setup Control Window Help

Welcome to SmartFusion2 FIC Tutorial

Please Select the Following option
1. Writing to the AM

2. Reading from the LSRAM

2. GPIO Blinking LED'=s

b

Figure 52 » Tera Term Window

9. Select Writing to LSRAM, It prompts for “Enter.the offset address between 0 to 8188 to write and

press Enter” as shown in Figure 53.
Note:

In PUTTY, press CTRL+J instead of Enter.

L COM28:37600baud - Tera Term VT

e B i) |

Eile Edit Setup Control Window Help

Welcome to SmartFusionZ FIC Tutorial

Please Select the Following option
1. Writing to the  LSHRAH

2. Reading from the LSRAH

2. GPIO Blinking LED'=s

1

Enter the Offszet address between A to 8188 to write and press Enter

Figure 53 * Writing to LSRAM
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10. After Entering the offset address, it prompts for “Enter data to write” as shown in Figure 54.

.

5 COM28:57600baud - Tera Term VT =] B e

File Edit 5Setup Control Window Help

Welcome to SmartFusion2 FIC Tutorial

Pleaze Select the Following option
1. Writing to the LSRAM

2. Reading from the LSERAM

i. GPIO Blinking LED's=s

Fotawn tha Nffeat adduacc hatusen A +n 2188 to write and press Enter
12

Enter the data to write and press Enter

Figure 54 « Writing to LSRAM

11. Select Reading from the LSRAM, it prompts for “Enter the offset address to read and press
Enter” as shown in Figure 55.

. COM28:57600baud - Tera Term VT E=REEE

Eile Edit Setup Control Window Help

Welcome to SmartFusion2 FIC Tutorial

Flease Select the Following option
1. UWriting to the LSHAM

2. Reading from the LSRAM

i- GPIO Blinking LED'=

Enter the Offzet address between B to 8188 to write and press Enter
2

Enter the data to write and press Enter
12345

Please Select the Following option
1. Writing to the LSRAM
2. Reading from the LSRAM
3. _GPIO Blinkina LFD'=
2
Enter the Offzet address between B to 8188 to read and press Enter

Figure 55 * Reading from LSRAM

12. Select GPIO LED Blinking, it Prompts for “Enter the number between 0 to 255 and press Enter”
as shown in Figure 56.
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Note: For SmartFusion2 Starter Kit Tera Term window as shown in Figure 57.

5 COM10:57600baud - Tera Term VT =] B e

File Edit 5Setup Control Window Help

Welcome to SmartFusion2 FIC Tutorial

Pleaze Select the Following option
1. Writing to the LSRAM

2. Reading from the LSRAM

g. GPIO Blinkina LED's

Enter the number bhetween B to 255 and press Enter

Figure 56 » Selecting GPIO LED Blinking

4 COM28:57600baud - Tera Term VT L= [ B e

File Edit 5Setup Control Window Help
Enter the Offset address between B to 8188 to write and press Enter -
12

Enter the data to write and pressz Enter

12345

Flease Select the Following option
1. Writing to the LSHAM

2. Reading from the LSEAM
3. GPIO Blinking LED’s
2

Enter the Offset address between A to 8188 to read and press Enter
12

Read Data:
12345

| Please Select the Following option
1. Writing to the LSRAM

2. Reading from the LSRAM

3. GPIO Blinking LED’=s

Enter the number bhetween B to 3 and press Enter

Figure 57 » Selecting GPIO LED Blinking
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Step 9: Building Executable Image in Release mode

You can build an application executable image in —release modell and load it into eNVM for executing
code in eNVM of SmartFusion SoC device. You can load the application executable image into eNVM
with the help of eNVM data storage client from System Builder eNVM Configurator. In release mode, you
cannot use SoftConsole debugger to load the executable image into eNVM.

Conclusion

This tutorial outlined the design flow for creating a SmartFusion2 SoC FPGA project using Libero SoC
design software, configuring the SmartFusion2 SoC FPGA MSS, interfacing fabric peripherals to the
SmartFusion2 SoC FPGA MSS using fabric interface controllers (FIC_0 and FIC_1), simulation of the
design using BFM commands and running the application design on board.

50 Revision 9



& Microsemi

A — List of Changes

The following table lists the critical changes that were made in each revision.

Revision Changes Page
Revision 9 Updated the document for Libero v11.4 software release (SAR 59820). NA
(August 2014)

Revision 8 Updated the document for Libero v11.3 software release (SAR 56454). NA
(May 2014)

Revision 7 Updated the document (SAR 54212). NA
(February 2014)

Revision 6 Updated the document for Libero version 11.2 (SAR 52904). NA
(November 2013)

Revision 5 Updated the document for 11.0 production SW release (SAR 47302). NA
(April 2013)

Revision 4 Updated the document for Libero 11.0 Beta SP1 software release (SAR NA
(February 2013) [44868).

Revision 3 Updated the document for Libero 11.0 Beta SPA software release (SAR NA
(November 2012) [42904).

Revision 2 Updated the document for Libero 11.0 Beta launch (SAR 41696). NA
(October 2012)

Revision 1 Updated the document for LCP2 software release (SAR 38954). NA
(May 2012)

Note: The revision number is located in the part number after the hyphen. The part number is displayed at the bottom
of the last page of the document. The digits following the slash indicate the month and year of publication.
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B — Product Support

Microsemi SoC Products Group backs its products with various support services, including Customer
Service, Customer Technical Support Center, a website, electronic mail, and worldwide sales offices.
This appendix contains information about contacting Microsemi SoC Products Group and using these
support services.

Customer Service

Contact Customer Service for non-technical product support, such as product pricing, product upgrades,
update information, order status, and authorization.

From North America, call 800.262.1060
From the rest of the world, call 650.318.4460
Fax, from anywhere in the world, 408.643.6913

Customer Technical Support Center

Microsemi SoC Products Group staffs its Customer Technical Support Center with highly skilled
engineers who can help answer your hardware, software, and design questions about Microsemi SoC
Produc